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ABSTRACT 

This research presents a miniaturized microstrip Ultra-Wideband (UWB) antenna based on double square 

ring Metamaterial (MTM) for modern wireless communication devices. The MTM unit cells are placed on 

the back of the antenna to help improve antenna parameters (i.e., bandwidth, gain, radiation pattern, and 

efficiency). The antenna is based on an FR-4 substrate with a thickness of 1.5 mm, a relative permittivity of 

4.4, and a dielectric loss tangent of 0.02. To achieve a solution in the frequency domain, simulations were 

performed using Ansys High-Frequency Structure Simulator (HFSS) software, an electromagnetic wave 

simulator based on a Finite Element Method (FEM)). Furthermore, a feeder with a characteristic 

impedance of 50 Ω has been applied. To address the computational time challenges associated with 

electromagnetic simulators like HFSS, Machine Learning (ML) in the form of an Artificial Neural 

Network (ANN) has been employed to optimize the antenna prior to the implementation of the MTM 

structure. The antenna's overall surface area is 24 × 12 mm2, with an absolute bandwidth of 15.53 GHz, 

ranging from 3.83 GHz to 19.36 GHz. The maximum efficiency and gain are 98.79 % and 4.72 dB, 

respectively. The UWB antenna demonstrates superior performance in comparison to the results reported 

in recent studies employing MTMs and ML principles for optimization. 

Keywords-microstrip antenna; miniaturized; metamaterials; Artificial Neural Network (ANN); Ultra-

Wideband (UWB) 

I. INTRODUCTION  

Ultra-Wideband (UWB) technology has emerged as a 
pivotal innovation in wireless communication, offering 
significant advantages such as high data rate transmissions, low 
power consumption, and resilience to multipath interference. 
Approved by the Federal Communications Commission (FCC) 
in 2002, the UWB spectrum (3.1–10.6 GHz) has prompted 
extensive research and development in high-bandwidth and 
short-range communication systems [1, 2]. Microstrip patch 

antennas have gained prominence among various antenna types 
due to their low profile, lightweight design, and ease of 
integration with microwave circuits [3]. These antennas, 
consisting of a dielectric substrate sandwiched between a 
metallic patch and a ground plane, are preferred for their cost-
effectiveness and simplicity in fabrication. However, 
conventional patch antennas face drawbacks, including narrow 
bandwidth, low gain, and limited efficiency [4, 5]. Overcoming 
these challenges has driven research into novel designs and 
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techniques, including introducing slotted ground planes, 
Defected Ground Structures (DGS), and innovative feedline 
methodologies. 

The advent of Metamaterial (MTM) engineered structures 
with properties like negative permittivity and permeability has 
further revolutionized antenna design. MTM-based antennas 
have remarkably improved bandwidth, gain, and radiation 
efficiency [6]. The incorporation of features such as Split Ring 
Resonators (SRRs) and Capacitance-Loaded Strips (CLS) into 
MTM antennas has been demonstrated to yield performance 
enhancements that surpass traditional designs [7-9]. These 
structures have shown potential for UWB applications, 
addressing the challenges of compactness, efficiency, and 
performance within the FCC-defined spectrum. 

Another critical consideration in modern antenna design is 
the integration of Machine Learning (ML) techniques to 
streamline development processes. High-frequency 
Electromagnetic simulations, while accurate, are 
computationally intensive and time-consuming [10]. ML 
models, such as Artificial Neural Networks (ANNs), offer a 
promising alternative for the modeling and optimization of 
complex antenna designs [11]. By learning the underlying 
relationships between geometric parameters and performance 
metrics, ML-based approaches can significantly reduce the 
iterative simulation burden and accelerate the design cycle [12, 
13]. Recent studies have demonstrated the efficacy of ML in 
predicting parameters such as return loss, gain, and radiation 
patterns, thereby facilitating the design of efficient and 
innovative antenna structures. 

This study presents the design and analysis of a miniature 
MTM-based monopole antenna for UWB wireless 
communication systems. The proposed design leverages the 
properties of MTMs and the predictive capabilities of ML to 
achieve enhanced bandwidth, gain, and compactness. The 
antenna under consideration incorporates double negative 
MTM on the bottom substrate and is optimized using ML 
algorithms to predict and refine its performance.  

II. MATERIALS AND METHODS 

A. Unit Cell Design 

Geometrically, the unit cell comprises two double square 
copper string patches of 0.035 mm thickness, as illustrated in 
Figure 1. 

 

 
Fig. 1.  2D view of the MTM unit cell. 

The patches are printed on a FR-4 substrate material with a 
thickness of 1.5 mm and a dielectric constant of 4.4. This 
geometrical arrangement introduces a magnetic field within the 
double square, which is responsible for negative permeability. 
The inner square stripe exhibits a rectangular gap (g1) with a 
width of 0.4 mm, introducing capacitance. Conversely, the 
outer square stripe is closed, leading to a reduction in series 
capacitance and an enhancement in coupling between the two 
square patch stripes. The design parameters of the proposed 
unit cell are as shown in Table I. 

TABLE I.  MTM UNIT CELL DESIGN PARAMETERS 

Parameter Dimensions (mm) 

ls 6.2 

L 5 

g 0.7 

g1 0.4 

h 1.5 

g2 0.4 

 

B. Metamaterial Unit Cell Analysis 

The MTM is placed between two waveguide ports along 
the positive and negative z-axis, facilitated by a waveport in 
Ansys High-Frequency Structure Simulator (HFSS). As the 
ideal magnetic conductor was placed perpendicular to the y-
axis, the ideal electric conductor boundary was placed 
perpendicular to the x-axis. The operating frequency ranges 
from 2 to 20 GHz with an input normalized impedance of 50 
Ω. 

As indicated in [8, 14], the operation wavelength in the 
media should exceed the MTM unit cells. Figure 2 illustrates 
the S�� and S�� of the proposed SRR unit cell. The simulated 
S-parameters were exported to MATLAB for enhanced 
analysis and extraction of the electromagnetic properties. 

 

 
Fig. 2.  MTM unit cell reflection and transmission coefficients. 

A robust method is employed to verify the electromagnetic 
characteristics of the proposed SRR MTM [15, 16]. The robust 
method is well suited due to its ability to perform better in 
extreme cases, such as high or low frequencies, and better 
accuracies [17]. Equations (1) through (9) are employed to 
retrieve the electromagnetic parameters. 
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where R₀₁ � �� � 1�/�� ! 1� , d  denotes the unit cell 
thickness, k₀ represents the wavenumber in free space, and � 
denotes the impedance. 

real ��� ) 0     (3) 

imaginary �n� ) 0    (4) 

� � 01��23₁₁�²�3₂₁²
���3₁₁�²�3₂₁²     (5) 

e678₀9 � X 0 i;1 � X²    (6) 

where X � �
�3₂₁���3₁₁²23₂₁²�. 

n � �
8<9 × 

=>imaginary>lne678<9? ! 2mπ? � i Breal>lne678₀9?CD (7) 

where m is an integer value, and n is the refractive index. 

Permeability, μ � n�    (8) 

Permittivity, ϵ � 7
�     (9) 

The simulated real and imaginary parts of the effective 
permeability, permittivity, and refractive index for the unit cell 
are demonstrated in Figures 3 through 5. 

The estimated MTM unit cell's negative permeability (μ) 
ranges from 2 GHz to 15.8462 GHz and from 19.3378 GHz to 
beyond 20 GHz, as shown in Figure 4. As illustrated in Figure 
3, the suggested MTM unit cell's negative permittivity (ϵ ) 
ranges from 2.1204 GHz to 10.4883 GHz and from 15.0033 
GHz to 15.786 GHz. If a unit cell's permittivity and 
permeability stay negative at the same time, the refraction 
index will also be negative [18, 19]. As illustrated in Figure 5, 
a negative effective refractive index ( n ) is observed from 
2.1204 GHz to 15.786 GHz. In the frequency range from 
2.1204 GHz to 10.4883 GHz, the permeability, permittivity, 
and refractive index all exhibit negative values, indicating that 
the proposed unit cell possesses negative MTM properties. 

C. Configuration of the Proposed Antenna 

The design of the primary antenna (ANT1), as illustrated in 
Figure 6, consists of a circle and a rectangle, forming the 
radiating patch on top of a substrate. The substrate material of 
the antenna is a FR-4 epoxy substrate, with a relative dielectric 
constant (ϵL) of 4.4, a height of 1.5 mm, and 0.02 as the loss 
tangent (tan δ). Essentially, the ground plane has undergone 
further modification, entailing the removal of triangular 
extracts from the corners and the top edge, situated just below 
the feedline. The objective of the removal is to aid the antenna 
in achieving UWB characteristics. The optimal design 
parameters of ANT1 are illustrated in Table II, as determined 
by parametric analysis. 

  
Fig. 3.  MTM unit cell permittivity. 

  
Fig. 4.  MTM unit cell permeability. 

 
Fig. 5.  MTM unit cell refractive index. 
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Fig. 6.  Proposed antenna structure for ANT1. 

TABLE II.  DESIGN PARAMETERS OF THE PROPOSED 
ANTENNA (ANT1) 

Parameter 
Dimensions 

(mm) 
Parameter 

Dimensions 

(mm) 

Lsb 24 Wf 3.5 

Wsb 12 Stri 2.828 

Rpc 5.7 Lf 10.025 

Lpr 5 Lg 7 

Wpr 12 Lgd2 3 

Lgd1 3 Wgd2 4.4 

Wgd1 6.7   

 

D. ANN Modelling 

The objective of using ML at this stage is to ensure an 
optimal design (ANT2) prior to the introduction of MTMs. 
ANT2 is obtained from ANT1. For this stage, the MATLAB 
software was used to train the Multilayer Perceptron (MLP). 
The tool was used with feedforward backward propagation. 

The present study utilized a total of 678 samples, 
incorporating 19 input features to generate 11 output features. 
The samples were generated from parametric analysis 
performed on ANT1 using HFSS software. Table III offers a 
comprehensive overview of the parametric analysis 
methodology employed to obtain the 678 samples. Each 
parameter was modified individually, while the remaining 
parameters remained constant. The parameter under 
observation was modified according to the steps provided. The 
start and end values were selected in such a way that they do 
not have ambiguous deformations for the antenna.  The 11 
geometric features are as follows: Lg, Lgd1, Wgd1, Lgd2, 
Wgd2, Wf, Rpc, Lpr, Wpr, Stri, and Lf. The output return loss 
values at the following frequency points are to be considered: 2 
GHz, 3.05 GHz, 4.11 GHz, 5.17 GHz, 6.23 GHz, 7.29 GHz, 
8.33 GHz, 9.41 GHz, 10.47 GHz, 11.52 GHz, 12.58 GHz, 
13.64 GHz, 14.70 GHz, 15.76 GHz, 16.82 GHz, 17.88 GHz, 
18.94 GHz, and 20 GHz, with the addition of the average gain, 
summing to 19 features. In HFSS, the geometric features are 
treated as inputs, as the return loss values and the average gain 
are outputs. This is reversed when using the neural network 
model where the 18 return loss values plus 1 gain value are fed 
into the model to generate the geometric values for the desired 
optimal antenna. Of the 678 samples collected, 70% are used to 
train the model, followed by 15% for model validation and 
15% for testing. 

TABLE III.  START AND END VALUES FOR PARAMETRIC 
ANALYSIS ON GEOMETRIC PARAMETERS FOR ANT1 

Parameter Start End Step 

Lg 5.7 7 0.025 

Lgd1 0.3 5 0.094 

Wgd1 5.7 10 0.05 

Lgd2 0.3 3 0.005 

Wgd2 2 6 0.05 

Wf 3.2 3.8 0.01 

Rpc 5.1 5.7 0.01 

Lpr 1 7 0.1 

Wpr 6 12 0.1 

Stri 5 7 0.05 

Lf 1.7 4.7 0.075 

 
The ANN architecture used for the design and validation of 

the microstrip patch antennas is based on the hidden and output 
layers. The transfer functions used in this neural network 
architecture include the pure linear transfer function (purelin) 
applied to the hidden layer and the hyperbolic tangent sigmoid 
transfer function (tansig) applied to the output layer. 

The neural network training process, implemented using 
MATLAB's nntraintool, employs the Levenberg-Marquardt 
training algorithm and uses Mean Squared Error (MSE) as the 
performance metric. During training, several key metrics are 
monitored to ensure proper convergence and model 
optimization. MSE represents the mean squared error between 
the predicted outputs and the target outputs. Initially, the MSE 
is high (33.1), but it decreases significantly during training to 
0.00324, indicating improved model accuracy as training 
progresses. The gradient reflects the rate of change of the 
performance function with respect to the weights. As training 
progresses, the gradient decreases from 46.7 to 0.000743, 
indicating that the model is approaching convergence. The 
damping parameter, Mu, is a part of the Levenberg-Marquardt 
optimization and controls the step size during training. Initially 
set to 0.001, Mu decreases to 1.00e-05, indicating that the 
model is fine-tuning the weights as it nears convergence. 
Validation checks are utilized to monitor the performance of 
the model on a validation dataset. In this case, six validation 
checks were performed, ensuring that the model generalizes 
well without overfitting. 

To determine the best number of neurons for the hidden 
layer, the MSE for different neurons was determined, as shown 
in Figure 7. The figure shows that 30 neurons give the lowest 
MSE value of 0.002512. The R-value of the regression 
indicates the correlation between the target and the output, with 
R-values closer to one suggesting a highly similar relationship. 
In an ideal scenario, the target and the outputs are the same. 
The MSE and R-values are calculated using the following 
equations [10]. 

MSE � �
P ∑ �R6 � P6��P6R�     (10) 

R � 11 � ∑��
�S
�²
∑��
��T�²    (11) 

where N is the number of testing or training samples, P6 are the 
predicted output values, R6 are the target output values; RV is 
the mean value of R6. 
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Fig. 7.  Plot of MSE against several neurons. 

The MSE value of the training approaches zero and was 
found to be 0.0043996, and R was found to be 0.99845. 
Considering the rest of the values, MSEs can be said to 
approach zero, while R values vary between 0 to 1 [10]. The 
training, validation, test results, and actual values are plotted 
against one another in Figure 8. The value of the training 
results is 99.845%. In general, a value between 80% and 90% 
is good for training in ANN applications. In this study, the 
estimation percentage of the data equals 99.831%. 

 

 
Fig. 8.  Regression graphs of S�� and gain versus geometrical parameters. 

The trained model provides the best geometric values of the 
optimum antenna, as shown in Table IV. When these values are 
inserted and simulated in the HFSS antenna design, a wide 
bandwidth is obtained for ANT2. This is an improvement from 
what was obtained in the initial design (ANT1) with an 
increase of 7.03 GHz. 

TABLE IV.  OPTIMIZED PARAMETERS OF THE PROPOSED 
ANTENNA (ANT2) 

Parameter 
Dimensions 

(mm) 
Parameter 

Dimensions 

(mm) 

Lsb 24 Wf 3.36 

Wsb 12 Stri 2.4 

Rpc 5.85 Lf 8.9 

Lpr 5.98 Lg 7.084 

Wpr 11.63 Lgd2 3 

Lgd1 2.709 Wgd2 4.3976 

Wgd1 7.597   

 

E. Metamaterial based Antenna 

The optimal position of the MTM was found to be as 
demonstrated in Figure 9 using parametric analysis. The initial 
step in performing a parametric analysis is to initiate the ANT2 
setup in HFSS, where two new variables, designated as $LO 
and $LP, are introduced. These values are determined in such a 
way that their addition or subtraction alters the general position 
of the MTMs, causing them to move on either side of the x-
axis. The MTMs are not supposed to make contact with the 
ground or extend beyond the substrate on the positive side of 
the x-axis, meaning their movement is bound.  

 

 
Fig. 9.  Proposed antenna structure with 2 MTM unit cells. 

The parametric analysis was conducted on a single MTM 
unit cell prior to the addition of the second cell; therefore, the 
cells are not on the same line, as illustrated in Figure 9. The 
procedure can be summarized as follows: 

1. The antenna model (ANT2) is opened in HFSS. 

2. The parameters to be analyzed ($LO and $LP) are added 
on 'Project', i.e. Project > Project variables > Add > Add 
property. 

3. Now the parameters/variables are incorporated into the 
MTM unit cells specifically to impact the x-axis 
movement, e.g. -1 mm + $LP, -6 mm, 0 mm in this format 
'x, y, z' axes. 



Engineering, Technology & Applied Science Research Vol. 15, No. 4, 2025, 24125-24133 24130  
 

www.etasr.com Ndete et al.: Design and Analysis of a Miniaturized-Metamaterial-Based Monopole Antenna for Ultra … 

 

4. Configure the parametric analysis: This is made possible 
by going to the Optimetrics, i.e. Optimetrics > Add 
parametric setup > Add > Variable ($LO) > Linear step > 
Define the start value, end value and the steps. 

5. Start the simulation: Click 'Analyze All' to run the 
parametric sweep. This can be found by right clicking on 
the HFSS design just below the project name. HFSS will 
automatically solve the design for each combination of 
parameter values. 

The return loss plot illustrated in Figure 10 (ANT3) shows 
the final optimized antenna. 

III. RESULTS AND DISCUSSION 

This section presents the antenna parameters of return loss, 
bandwidth, gain, radiation pattern, and efficiency of the three 
antennas (ANT1, ANT2, and ANT3). 

A. Return Loss 

This is a measure of the electrical power delivered into an 
antenna from a feed point [20-24]. It indicates good impedance 
matching when the values of S��  are negative, and for the 
antenna to perform better in real-time applications, these values 
should be less than -10 dB [25]. Good impedance matching 
means less reflected power and maximum power delivered into 
the antenna. Figure 10 shows the return loss plots for the three 
antennas described in this analysis: the reference antenna, 
ANT1, which exhibits a first resonance near 4.2 GHz, a second 
resonance near 10.26 GHz, and a third and final resonance near 
17.44 GHZ, leading to return losses of -19.178 dB, -20.66 dB, 
and -11.68 dB, respectively. ANT2 was designed using the 
ANN, and had five resonance points: 4.3 GHz, 7 GHz, 11.34 
GHz, and 15.85 GHz with return losses of -18.88 dB, -15.29 
dB, -28.44 dB, -19.79 dB, and 17.88 GHz with a return loss of 
-25.63 dB. The proposed antenna (ANT3) has the same 
resonant frequencies plus a lower return loss of -36.24 dB at 
17.7 GHz. Other resonant frequencies are 4.3 GHz, 7.05 GHz, 
10.48 GHz, 10.93 GHz, and 11.79 GHz with return loss of -
19.5 dB, -14.75 dB, -28.07 dB, -27.67 dB, and -33.6 dB, 
respectively. The improvements in ANT3 demonstrate the 
effect of the MTM on the antenna resonant frequencies. 

B. Bandwidth 

The bandwidth of an antenna is where it can effectively 
operate in terms of receiving and transmitting power. Return 
loss curves are used to determine the antenna bandwidth. This 
means that the bands operating below the -10 dB line are 
considered to be the antenna bandwidth. As illustrated in 
Figure 10, ANT1 exhibits two multi-bands, 3.8 GHz to 12.38 
GHz and 16.08 GHz to 18.9 GHz, with an impedance 
bandwidth of 8.58 GHz and 2.82 GHz, respectively. The 
second antenna (ANT2) can achieve a wide bandwidth from 
3.85 GHz to 19.46 GHz with an impedance bandwidth of 15.61 
GHz. The resonant frequency with the lowest return loss for 
this antenna is 11.34 GHz. In addition to the highest resonant 
frequencies, the proposed antenna has an ultra-wide bandwidth 
from 3.83 GHz to 19.36 GHz, with an impedance bandwidth of 
15.53 GHz. 

 
Fig. 10.  Reflection coefficients for the three antennas (ANT1, ANT2, and 
ANT3). 

C. Radiation Pattern 

The radiation pattern is a critical parameter for evaluating 
an antenna's performance, as the primary function of an 
antenna is to radiate. Figure 11 presents simulated 3D views of 
the far-field radiation patterns for the three antennas at 6.85 
GHz. The colors red and blue indicate the strongest and 
weakest radiation, respectively. The radiation pattern indicates 
omnidirectional radiation, with the proposed antenna (ANT3) 
having a maximum power of 21.27 dB compared to ANT2 and 
ANT1 with 21.25 dB and 20.99 dB, respectively. This indicates 
a significant advantage in ultra-wideband communication 
systems. 

 

 
Fig. 11.  3D radiation pattern at 6.85GHz: (a) ANT1, (b) ANT2, (c) ANT3. 

D. Gain 

Gain is a factor that describes how directional the antenna 
is; a low gain antenna means that the antenna can radiate in all 
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directions, as opposed to a high gain antenna that is specific to 
a particular direction. As shown in Figure 12 and Table V, 
ANT1 has a peak and average gain of 6.78 dB and 4.63 dB, 
respectively. At the same time, ANT2 has a peak and average 
gain of 6.83 dB and 4.35 dB, respectively, whereas ANT3 has a 
peak and average gain of 6.88 dB and 4.72 dB, respectively. It 
is worth noting the effect of the MTM on the gain of the 
antenna, increasing it by 0.37 dB (average gain) over ANT2 
and 0.09 dB over ANT1. The E-plane and H-plane plots for the 
three antennas (ANT1, ANT2 and ANT3) at a frequency of 6.5 
GHz are shown in Figure 13 to 15, respectively. It is observed 
that ANT3 has the highest gain among the three antennas of 
3.661 dB in the E-plane and 3.3416 dB in the H-plane. 

E. Efficiency 

Antenna efficiency is evaluated as the ratio of energy input 
to energy output. A highly efficient antenna will radiate most 
of the power applied to its input, whereas a less efficient 
antenna will lose some of its power due to internal losses or 
impedance mismatch-induced reflection. The efficiency is 
identical for transmitting and receiving antennas, and it is more 
intuitive to consider efficiency the as the proportion of energy 
radiated compared to the energy supplied. It can be expressed 
as η � Energy radiated Energy input⁄ . 

 

 
Fig. 12.  Gain plots for the three antennas (ANT1, ANT2 and ANT3). 

 
Fig. 13.  E-plane and H-plane gain plots for ANT1 at 6.5 GHz. 

 
Fig. 14.  E-plane and H-plane gain plots for ANT2 at 6.5 GHz. 

 
Fig. 15.  E-plane and H-plane gain plots for ANT3 at 6.5 GHz. 

Figure 16 shows the radiation efficiency curves for the 
three antennas. What is common is a radiation efficiency of 
more than 85% across the entire band. However, ANT3 has the 
highest value of maximum efficiency (98.8 %). It clearly shows 
that the proposed antenna efficiently radiates the power 
generated at the input.  

 

 
Fig. 16.  Radiation efficiency and gain plots of the three antennas (ANT1, 
ANT2 and ANT3). 
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Table V shows a summary of the performance of the three 
antennas, i.e., ANT1, ANT2, and ANT3. 

TABLE V.  COMPARISON OF ANT1, ANT2, AND ANT3 

Parameter ANT1 ANT2 ANT3 

Bandwidth (GHz) 
3.8 - 12.38,  
16.08 - 18.9 

3.85 - 19.46 3.83 - 19.36 

Fractional bandwidth 
(%) 

106, 16.1 134 133.93 

Average gain (dB) 4.6279 4.35 4.72 

Peak gain (dB) 6.777 6.8267 6.88 

Max radiation 
efficiency (%) 

98.33 98.85 98.79 

 

IV. COMPARISON OF THE PROPOSED WORK WITH 
RECENT STUDIES 

In order to demonstrate the advantages of the proposed 
antenna, the performance of related antennas in the literature 
are studied to avoid impartiality in the analysis. Table VI 
presents a comparative study between the proposed ultra-
compact UWB antenna and previously published designs in 
terms of size, bandwidth, peak gain and efficiency. While 
previous studies have employed various design techniques such 
as slot loading [2, 26], MTM unit cells [18], and defected 
ground structures [27], the proposed work leverages an MTM-
based design with negative index characteristics, which is 
optimized using ML (ANN). Compared to previous designs, 
the proposed antenna is among the smallest, with overall 
dimensions of 24 × 12 × 1.5 mm³. The closest in size is the 
design in [2] (13 × 27.2 × 1.5 mm³), but it offers a significantly 
lower bandwidth (2.8382–9.0682 GHz) and peak gain (2.6 dB). 
Most other designs are notably larger, such as [27] (30 × 20 × 
0.8 mm³) and [28] (30.8 × 27.6 × 0.8 mm³), yet they do not 
achieve a comparable gain or efficiency. The proposed antenna 
exhibits an exceptionally wideband response, covering 3.83–
19.36 GHz with an overall bandwidth of 133.93%. This 
significantly surpasses designs such as [1] (3.581–3.935 GHz) 
and [26] (3–11 GHz). The closest competing design in terms of 
bandwidth is [27] (3.15–22.85 GHz), but it has a much lower 
gain (4.4599 dB) and efficiency (95.779%). By achieving a 
peak gain of 6.88 dB, the proposed antenna provides a stronger 
signal compared to all listed designs, surpassing even the best-
performing [18] (6.12 dB). Additionally, it achieves an 
exceptional efficiency of 98.79%, which is among the highest 
reported, slightly exceeding [20] (98.44%). Most of the other 
antennas, such as [28] (92.28%) and [1] (82%), demonstrate 
lower efficiency, highlighting the superior design of the 
proposed model. 

TABLE VI.  COMPARISON OF PRESENT WORK WITH 
PREVIOUSLY PUBLISHED WORK 

Ref. 
Antenna size 

(mm3) 

Bandwidth 

(GHz) 

Peak gain 

(dB) 

Efficiency 

(%) 

[1] 27×25×1.5 3.581–3.935 4.7 82 

[2] 13×27.2×1.5 2.8382–9.0682 2.6  

[18] 14.5×22×1.6 3.08–14.1 6.12 97 

[20] 21×27×1.6 3.16–14.36 4.1 98.44 

[26] 25×22×1.6 3–11 4.1 85 

[27] 30×20×0.8 3.15–22.85 4.4599 95.779 

[28] 30.8×27.6×0.8 3.5–14.5 2.8 92.28 

Proposed 24×12×1.5 3.83–19.36 6.88 98.79 

V. CONCLUSION 

This work presents a miniaturized Ultra-Wideband (UWB) 
microstrip patch antenna based on Metamaterial (MTM) with 
negative index characteristics, which is designed using Ansys 
High-Frequency Structure Simulator (HFSS) and successfully 
optimized using Machine Learning (ML), specifically Artificial 
Neural Network (ANN). This simulated negative index MTM 
antenna gives an overall bandwidth of 133.93%. The designed 
antenna, operating from 3.8 GHz to 19.3 GHz, exhibits UWB 
characteristics, making it suitable for various wireless 
applications. Its high efficiency (98.79%) and peak gain (6.88 
dB) enable its use in UWB communications (3.1–10.6 GHz), 
5G sub-6 GHz and mmWave networks, radar and imaging 
systems (X-band, Ku-band), satellite communications, and RF 
energy harvesting. Its compact size (24 × 12 × 1.5 mm) allows 
integration into miniaturized and wearable devices, enhancing 
portability and versatility. Given these attributes, the antenna 
demonstrates strong potential for next-generation wireless 
systems, facilitating high-speed data transmission, precise 
sensing, and efficient energy transfer. The proposed antenna 
exhibited excellent radiation patterns, operating as an 
omnidirectional at the UWB center frequency. The fabrication 
of the suggested antenna, as well as an assessment of the 
effectiveness of the practical and simulated antennas, will be 
the main topics of future work. 
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